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FCC Warning 
This device complies with Part 15 of the FCC Rules. Operation is subject to 
the following two conditions: 
(1) this device may not cause harmful interference, and (2) this device must 
accept any interference 
received, including interference that may cause undesired operation. 
 
 
 
CAUTION:  
Changes or modifications not expressly approved by the party responsible 
for compliance could void the user's authority to operate the equipment. 
 
FCC RF exposure requirements:  The antenna(s) used for this transmitter 
must be installed to provide a separation distance of at least 20 cm from all 
persons and must not be co-located or operating in conjunction with any 
other antenna or transmitter.  
 



 1 

Contents  
CONTENTS ...............................................................................................................................1 
ABOUT THIS GUIDE............................................................................................................3 

INTRODUCTION....................................................................................................................3 
SYSTEM REQUIREMENT ..................................................................................................3 
FEATURES AND BENEFITS ..............................................................................................4 

PHYSICAL DESCRIPTION.................................................................................................6 
FRONT PANEL.........................................................................................................................6 
REAR PANEL ...........................................................................................................................7 
BOTTOM PANEL......................................................................................................................8 

UNPACKING THE DCS-1000W.........................................................................................9 
HARDWARE INSTALLATION..........................................................................................9 

CONNECTING THE DCS-1000W  TO THE CAMERA STAND .............................................10 
SECURITY.............................................................................................................................. 11 
SOFTWARE INSTALLATIO N........................................................................................ 12 

WEB CONFIGURATION.........................................................................................................12 
MAIN MENU IMAGE.............................................................................................................13 
SYSTEM ADMINISTRATION.................................................................................................13 
SYSTEM ADMINISTRATION.................................................................................................14 

System Administration – System................................................................................. 14 
System Administration - Image................................................................................... 21 
System Administration - Users.................................................................................... 23 
System Administration – DateTime ............................................................................ 24 
System Administration – Trigger................................................................................ 26 
System Administration - Information......................................................................... 28 
System Administration - Information......................................................................... 28 
System Administration - Tools .................................................................................... 28 

VIEW IMAGE – ACTIVEX MODE.........................................................................................29 
VIEW IMAGE – JAVA MODE................................................................................................31 

IPVIEW APPLICATION INSTALLATIO N ................................................................ 32 

INSTALLATION......................................................................................................................32 
IPVIEW – GETTING STARTED..................................................................................... 38 

IPVIEW ..................................................................................................................................38 
HOW TO CHANGE PASSWORD.............................................................................................39 

Change Password.......................................................................................................... 39 



 2 

HOW TO CHANGE IP ADDRESS...........................................................................................40 
Change IP Address ....................................................................................................... 40 

HOW TO ADD A CAMERA....................................................................................................42 
Add Camera ................................................................................................................... 42 

HOW TO DELETE A CAMERA ..............................................................................................45 
Delete Camera ............................................................................................................... 45 

HOW TO VIEW A CAMERA...................................................................................................46 
View Camera .................................................................................................................. 46 

HOW TO TAKE A SNAP -SHOT OF A CAMERA ....................................................................47 
Snap shot Camera ......................................................................................................... 47 

HOW TO ADJUST THE PROPERTY SETTING.......................................................................47 
Property Setting............................................................................................................. 47 
Menu Bar........................................................................................................................ 54 
Menu Bar - File ............................................................................................................. 54 
Menu Bar – View........................................................................................................... 55 
Columns.......................................................................................................................... 55 
Viewing Format............................................................................................................. 55 
List View ......................................................................................................................... 56 
Menu Bar - Camera ...................................................................................................... 57 
Enable Function ............................................................................................................ 57 
Menu Bar - Tools........................................................................................................... 57 
Menu Bar - Help............................................................................................................ 57 

IPVIEW ICON DESCRIPTION................................................................................................58 
CONTEXT SENSITIVE MENU................................................................................................59 

UNINSTALL IPVIEW APPLICATION......................................................................... 60 
APPENDIX.............................................................................................................................. 62 

FREQUENTLY ASKED QUESTIONS......................................................................................62 
TROUBLE SHOOTING............................................................................................................63 
HOW TO PING YOUR IP ADDRESS....................................................................................66 
I/O CONNECTOR ...................................................................................................................67 
UPGRADE FIRMWARE ..........................................................................................................69 
TIME ZONE TABLE ...............................................................................................................70 
XPLUG CONTROL INSTALLATION......................................................................................72 

Installation to a Local PC............................................................................................ 73 
ADJUSTING THE CAMERAS FOCUS.....................................................................................75 
REPLACING THE LENS..........................................................................................................77 

SPECIFICATIONS ............................................................................................................... 78 
TECHNICAL SUPPORT.................................................................................................... 80 

REGISTRATION.................................................................................................................. 80 



 3 

About This Manual 
 
This manual describes the DCS-1000W, including a description of its features, 
as well as installation procedures and web configuration instructions. Included 
are the operating procedures for the IPView Remote Monitoring Application. 
 
 

Introduction 
 
The DCS-1000W connects directly to an Ethernet, Fast Ethernet, or 802.11b 
Network. It is different from the conventional PC Camera because the DCS-
1000W is a standalone system with a built-in CPU and web server providing a 
low cost solution that can transmit high quality video images for monitoring. 
The DCS-1000W can be accessed remotely, and controlled from any 
PC/Notebook over the Intranet or Internet via a web browser. The simple 
installation procedures and web-based interface offers easy integration to your 
network application environments coupled with many applications such as 
remote monitoring for a cost-effective solution. 
 

System Requirement 
 
Local Area Network: 10Base-T Ethernet or 100Base TX Fast Ethernet 

Wireless Local Area Network:  IEEE 802.11b Wireless LAN 

Recommended:  PC or Notebook to Access the Wireless Internet 
Camera 

Web Configuration: 

• Java Enabled and Compliant Web Browser 
• CPU: Pentium II, 266 MHz or above 
• Memory Size: 32 MB (64 MB recommended) 
• VGA card resolution: 800x600 or above 
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IPView Configuration: 

• Windows XP, Me, 2000, 98Se or 98 
• Pentium II, 350 MHz or above 
• Memory Size of 128 MB (256 MB recommended) 
• VGA card resolution of 800x600 or above 
 

Features and Benefits 
 
This section describes the features and benefits of DCS-1000W 
 
Simple to Use 
 DCS-1000W is a standalone system with built-in CPU requiring no special 
hardware or software such as PC frame grabber cards. DCS-1000W supports 
both ActiveX mode for Internet Explorer and Java mode for Internet Explorer 
and Netscape Navigator. Therefore, all that is required is a computer with a 
web browser software such as Internet Explorer 4.0 or above or Netscape 4.0 
or above. Just plug and view the picture from your DCS-1000W with a valid 
IP Address. 
 
Supports a Variety of Platforms 
Supporting TCP/IP networking, SMTP e-mail, HTTP and other Internet 
related protocols. The DCS-1000W can be utilized in a mixed operating 
system environment such as Windows, Unix, and Macintosh. It can also be 
integrated easily into other Internet/Intranet applications because of its 
standards based features. 
 
Wired and Wireless Network Support 
The DCS-1000W supports both wired and wireless transmission providing the 
advantage of mobility, flexibility and high-speed of wireless LAN based 
technology, IEEE 802.11b, to transform DCS-1000W into a total solution for 
your network. There are three modes available configured from the slide 
switch on the rear panel. 

• LAN (Local Area Network Only) 
• LAN/WLAN (Local Area Network and Wireless Local Area Network. 

Both can be accessed at the same time.) 
• WLAN (Wireless Local Area Network Only) 
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Web Configuration 
Applying a standard web browser, administrators can configure and manage 
the DCS-1000W directly from its own web page via the Intranet or Internet. 
Up to 64 users name and password are permitted with privilege setting 
controlled by the administrator.  
 
Remote Monitoring Utility 
Powerful IPView application assigns administrator with a pre-defined user ID 
and password whom can modify DCS-1000W settings from the remote site via 
Intranet or Internet. When new firmware is available you can also upgrade 
remotely over the network for added convenience. Users are also allowed to 
monitor the image, record the image to hard drive, and take snapshots. 
 
Connection to External Devices 
Supporting auxiliary Input/Output connectors, you can connect the DCS-
1000W to a variety of external devices such as IR-sensors, switches and alarm 
relays. One can combine with programmable alarming facilities to develop a 
variety of security applications that are triggered on alarm-based events. The 
DCS-1000W provides up to two in/out external devices for connectivity. 
 
Broad Range of Applications 
With today’s high-speed Internet services, the DCS-1000W can provide the 
ideal solution for live video images over the Intranet and Internet for remote 
monitoring. DCS-1000W allows remote access from a web browser for live 
image viewing and allows the administrator to manage and control the DCS-
1000W anywhere and any time in the world. Apply DCS-1000W to monitor 
various objects and places such as homes, offices, banks, hospitals, child-care 
centers, amusement parks and other varieties of industrial and public 
monitoring. The DCS-1000W can also be used for intruder detection, capture 
still images and video images for archiving and many more applications.  
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Physical Description 
 
This section describes the externally visible features of DCS-1000W. 
 

Front Panel 
 
 
 
 
 
 
 
 
 
 
 
Power LED 
The Power LED is positioned on the right side of DCS-1000W’s lens while 
facing the DCS-1000W. Steady blue confirms DCS-1000W is powered on.  
 
Note: 
There are three settings for the Power LED to control the light illumination for 
monitoring purpose from Normal / Off / Dummy. Please refer to the Web 
Configuration section for detailed information and usage.  
 
LAN/WLAN LED 
The LAN/WLAN LED is positioned on the right side of DCS-1000W’s lens 
while facing the DCS-1000W. It is located right of the Power LED  
 
Steady orange confirms good connection to the LAN or WLAN. 
 
Dependent on the data traffic the LED will begin to flash to indicate that DCS-
1000W is receiving/transceiving from/to the LAN or WLAN network. 
 
Note : 
There are three settings for the LAN/WLAN LED to control the light 
illumination for monitoring purpose from Normal / Off / Dummy. Please refer 
to the Web Configuration section for detailed information and usage.  
 

Power LED 

LAN/WLAN LED 

 

Manual Focus Ring 
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Ethernet Cable 
Connector 

DC Power 
Connector 

I/O Connector 

Antenna Connector 
Slide Switch 

Reset Button 

Antenna Connector 

 

Rear Panel 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Network Cable Connector 
The DCS-1000W’s rear panel features an RJ-45 connector for connections to 
10Base-T Ethernet cabling or 100Base-TX Fast Ethernet cabling (which 
should be Category 5 twisted-pair cable). The port supports the NWay 
protocol, allowing DCS-1000W to automatically detect or negotiate the 
transmission speed of the network. 
 
DC Power Connector 
The DC power input connector is located on the DCS-1000W’s rear panel and 
is labeled DC 5V with a single jack socket to supply power to DCS-1000W. 
 
Reset Button 
Reset will be initiated when the reset button is pressed once and Power LED 
begins to flash. 
 
Factory Reset will be initiated when the reset button is pressed continuously 
for three seconds or when Power LED begins to light up. Release the reset 
button and the Power LED will begin to flash indicating that the DCS-
1000W’s settings are reverting back to the factory settings. When factory reset 
is completed DCS-1000W will be set to default on channel 11 and EES-ID is 
set as “NULL String” (This default setting will let DCS-1000W connect to 
ANY access point on the infrastructure network). The IP address will also 
return to the default setting as 192.168.0.20. 
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Slide Switch 
The slide switch permit user’s to determine the type of network 
communication media for the DCS-1000W and is positioned on the rear panel. 
The three settings are as follows: 

• LAN (Local Area Network Only) 
• LAN/WLAN (Local Area Network and Wireless Local Area Network. 

Both can be accessed at the same time.) 
• WLAN (Wireless Local Area Network Only) 

 
I/O Connector 
There are four I/O connectors, two for input and two for output situated on the 
rear panel. The I/O connectors provide the physical interface to send and 
receive digital signals to a variety of external alarm devices. Please refer to 
the User’s Guide appendix for detailed information. 
 
Antenna Connector 
There are two SMA type antenna connectors located at the rear panel of the 
DCS-1000W providing connection for two high sensitivity antenna included 
with the device. 
 

Bottom Panel 
 
 
 
 
 
 
 
 
 
 
Bracket Cavity 
Located on the bottom panel of DCS-1000W the bracket cavity is used to 
connect the camera stand onto DCS-1000W by attaching the screw head on 
the camera stand into the mounting cavity of DCS-1000W.  
 

Bracket Cavity 
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Unpacking the DCS-1000W 
Carefully remove all items from the package. In addition to this User’s Guide, 
be certain that you have: 
 

• One Wireless Internet Camera 
• Two External Wireless Antennas 
• One Installation CD-ROM  
• One AC power adapter 
• One Camera Stand 
• One Category 5 Ethernet Cable  
• This manual 

 
If any item is missing, or if you find any damage or mismatch, promptly 
contact your dealer for assistance. 
 

Hardware Installation 
This section describes the Hardware installation procedure for DCS-1000W. 
 
1. Attach Wireless Antenna 
 
From the rear panel of DCS-1000W screw 
the 2 external antennas that came with DCS-
1000W into the antenna connector. 
 
 
 
 
 
 
2. Configure Network Communication 
 
From the rear panel of DCS-1000W select the 
desired network communication for DCS-
1000W from the Slide Switch. Position the 
Slide Switch to the setting required either LAN 
or LAN/WLAN position. 
 
Please refer to the Physical Description 
section for detailed information. 
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3. Connect an Ethernet cable 
 
Connect an Ethernet cable to the network 
cable connector located on DCS-1000W’s rear 
panel and attach it to the network. 
 
 
 
 
 
 
4. Attach the external power supply 
 
Attach the external power supply to the DC 
power input connector located on DCS-
1000W’s rear panel and is labeled DC 5V 
and connect it to your local power supply. 
 
Note: 
Confirm power source is supplied from the 
LED indicators label Power on DCS-1000W 
is illuminated. 
 

Connecting the DCS-1000W to the Camera Stand 
 
DCS-1000W comes with a camera stand 
with a swivel ball screw head that can be 
attached to DCS-1000W's bottom bracket 
cavity. Attach the camera stand to DCS-
1000W and station it for your application. 
There are three holes located in the base 
of the camera stand allowing the DCS-
1000W to be mounted on the ceiling or 
any wall securely.  
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Security  
 
To ensure the highest security and prevent unauthorized usage of DCS-1000W 
the Administrator has the exclusive privilege to access System Administration 
setting to allow users the security level of entry and authorize privileges for all 
users. The DCS-1000W supports multi-level password protection/access to the 
DCS-1000W that can be restricted to defined users who has a "User Name" 
and "User Password" which is assigned by the Administrator.  
 
The administrator can release a public user name and password so when 
remote users access DCS-1000W they will have the right to view the image 
transmitted by DCS-1000W. 

 
Note: 
When the DCS-1000W is used for the first time it is highly recommended that 
the Administrator set the "Admin ID" and "Admin Password" to constrain user 
access to the DCS-1000W since the Default settings are Null String (no 
password). Once the ID and Password are defined only the Administrator has 
the access to management DCS-1000W. This procedure should be done as 
soon as possible since the security features with DCS-1000W will not be 
enabled until the "Admin ID" and "Admin Password" is defined. 
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Software Installation 
 
This section describes the Software installation procedure of the DCS-1000W 
for Web Configuration and the IPView application. 
 
Web Configuration 

• DCS-1000W must be configured through its built-in Web-based 
Configuration. 

 
From the web browser, enter the default IP address (192.168.0.20) to access 
the Welcome screen of the DCS-1000W. To configure your DCS-1000W type 
“http://192.168.0.20” in the address box of your favorite Web Browser. The 
number is the default IP address of your DCS-1000W. Press Enter. 
 

 
 
Note: 
The PC’s IP address must correspond with the DCS-1000W’s IP 
address in the same segment (i.e. PC=192.168.0.5, 
Camera=192.168.0.20) for the two devices to communicate. For 
instructions on how to do this, please access instructions for installing 
any of the D-Link Broadband Gateway products from 
support.dlink.com/products. The DI-713 or DI-714 are good products to 
use as an example as their Quick Install Guides are the most up-to-date. 
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Main Menu Image 
After the default IP address is entered from the browser DCS-1000W Home 
screen will appear with a still image. There will be three options to choose 
from to set-up and view your DCS-1000W and they are as follows: 

§ View Image – ActiveX Mode 
§ View Image – Java Mode 
§ System Administration 

 
 
System Administration 
Click on “System Administration” from the Home screen to access the 
settings required for DCS-1000W. 
 
There will be several options in the System menu bar to choose from to set 
your DCS-1000W and they are as follows: 

§ System 
§ Image 
§ Users 
§ Date/Time 
§ Trigger 
§ Information 
§ Tools 
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System Administration 
 
System Administration – System 
The System menu contains commands for settings that are required for 
inputting key details to set-up the DCS-1000W for operation. 
 
Click on "System" in the system administration menu bar and the System 
screen will appear as illustrated below: 

 

Click on “Home” to 
return to Home Screen 
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Camera Name:  
This field is used for entering a descriptive name for the device.  
 
The default setting for the Camera Name is CS-xxxxxx, where xxxxxx is the 
last six digit of the MAC Address. The maximum length is 32 (Printable 
ASCII). 
 
Location: 
This field is used for entering a descriptive name for the location used by 
DCS-1000W. 
 
Admin: 
This field is used for entering the Administrator ID along with the password to 
access the System Administration settings. Be sure to enter the password twice 
to confirm the details once in the Admin Password field and again in the 
Confirm Password field. 
 
The default setting for Admin is blank (Null String) you need to key in the 
Admin ID with a maximum length of 12 (Printable ASCII) characters and 
enter the Admin Password with a maximum length of 8 (Printable ASCII) 
characters.  
 
It is highly recommended to set the Admin ID and Admin Password as soon as 
possible to ensure the highest possible security. 
 
IP Assignment: 

Important Information 
 

Access to DCS-1000W is done through assigning a proper IP address. Please 
make sure to use a vacant IP address when you assign the IP address for DCS-
1000W. This will prevent errors from occurring if the IP address is overlapped.  

 
There are two options to select from the IP Assignment either Manually 
Assign or Assign Automatically Using. 
 
Manually Assign 

You can click “Manually Assign”  and directly enter the IP address. 
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The default settings are as follows: 
§ Default IP – 192.168.0.20  
§ Subnet Mask – 255.255.255.0  
§ Default Gateway – 0.0.0.0  

 
Assign Automatically Using 

Important Information 
 

It is recommended that you do not use an Automatically Assigned IP address as 
it may be difficult to determine the IP address of the unit after the IP address has 
been assigned. It is recommended that an IP address be assigned manually. 

 
If your network is using RARP, BOOTP or DHCP server you can click 
“Assign Automatically Using” and click on “RARP”, “BOOTP”  or 
“DHCP” . Under this setting DCS-1000W will automatically assign an IP 
address from RARP, BOOTP or DHCP server. Each time the DCS-1000W 
starts up be sure the RARP, BOOTP or DHCP server is setup as assign a static 
IP to your DCS-1000W. 
 
If your application requires a direct connection from an ADSL modem 
through the DCS-1000W’s RJ-45 LAN port and you also have an ISP PPPoE 
account, click on the “PPPoE” option and enter the Service Name, User ID 
and Password into the respective fields. 
 
The DCS-1000W will get an IP address from the ISP each time DCS-1000W 
starts up when Assign Automatically is used. 
 
DNS IP Address: 
DNS (Domain Name System) server is an Internet service that translates 
domain names (ie. www.dlink.com) into IP addresses (ie. 192.168.0.20). The 
DNS IP address can be received from your ISP. Enter at least one DNS IP 
Address. 
 
Wireless Interface: 
Connection Mode: 
Use the Connection Mode to determine the type of wireless communication 
for the DCS-1000W. There are three choices of Infrastructure mode , 802.11 
Adhoc mode  and Adhoc mode . The default setting for the Connection Mode 
is Infrastructure. 
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Note: 
Keep in mind that after setting the Wireless Interface make sure that the Slide 
Switch on the rear panel is positioned to either LAN/WLAN or WLAN setting 
for the wireless communication to take effect. 
 
Network Name: 
This field is used to setup which wireless network (ESS-ID Extended Service 
Set ID) DCS-1000W is to be connected for communication. The ESS-ID is a 
unique identifier shared among all points in a wireless network environment.  
 
The default Network Name is blank space (NULL String); this default setting 
will let the DCS-1000W connect to any access point under the infrastructure 
network mode. 
 
To connect the DCS-1000W to a specific access point on the network make 
sure that you set the ESS-ID of the DCS-1000W to correspond with the access 
point’s ESS-ID. Type any string up to 32 characters long (spaces, symbols, 
and punctuation are not allowed) in the Network Name box. 
 
To connect the DCS-1000W to an Ad-hoc wireless workgroup make sure that 
you set the same wireless channel and ESS-ID to match with the PC/Notebook 
wireless channel and ESS-ID for direct wireless communication under the Ad-
hoc wireless workgroup (ad-hoc and 802.11 ad-hoc modes). 
 
Note: 
The DCS-1000W supports two ad-hoc modes (802.11 ad-hoc mode and 
proprietary ad-hoc mode). Which option of the ad-hoc mode required depends 
on the operation of your DCS-1000W. It depends on which ad-hoc mode is 
supported by your wireless card driver on the PC/Notebook. Some driver 
supports both modes, however, some driver support only one of the modes. 
The names of each ad-hoc mode may not be consistent between each wireless 
card vendor therefore you may need to try each of the ad-hoc mode (802.11 
mode and proprietary mode) and select the mode that can communicate with 
each other. 
 
Wireless Channel: 
The pull down menu provides the wireless channel for communication. A 
"channel" is a range of frequencies to be used in communication between 
DCS-1000W and Access Point in infrastructure mode or DCS-1000W and 
PC/Notebook in Ad-hoc mode. Select the appropriate channel from the list 
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provided depending on the regulatory region which the unit is sold. The 
default setting is channel 11. 
 
Encryption WEP Key: 
Wireless network communications are easily intercepted. WEP (Wired 
Equivalent Privacy) is an encryption method specified by the IEEE 802.11b 
standard to make any intercepted communications extremely difficult to 
interpret by unauthorized parties. 
 
To enable WEP Encryption, first decide which WEP key format will be 
applied. Click on ASCII or HEX check box to select input format as ASCII 
format or HEX format, and then input the WEP key. To Confirm the WEP key 
you must enter the data once again in the Confirm WEP Key field.  
 
ASCII input format: 
ASCII format causes each character you type to be interpreted as an eight-bit 
value. All unaccented upper- and lower-case Western European characters that 
can be input through your keyboard's typing zone are valid. To setup 64-bit 
WEP key, input 5 ASCII characters, for example, ‘12345’. To setup 128-bit 
WEP key, input 13 ASCII characters, for example, ‘1234567890123’. These 
character counts result in bit counts of 40 and 104, respectively; the DCS-
1000W will automatically pad your input to a bit count of 64 or 128. 

HEX input format: 
Hex format causes each pair of characters you type to be interpreted as an 
eight-bit value in hexadecimal (base 16) notation. Only the digits 0 through 9 
and the letters A through F (in upper or lower case) are valid. To setup 64-bit 
WEP key, input 10 HEX format, for example, ‘3132333435’, this is the same 
with ASCII input ‘12345’. To setup 128-bit WEP key, input 26 HEX format, 
for example, ‘31323334353637383930313233’, this is the same with ASCII 
input ‘1234567890123’. These character counts result in bit counts of 40 and 
104, respectively; the DCS-1000W will automatically pad your input to a bit 
count of 64 or 128. 
 
On the Confirm WEP Key field, input the same characters as the Encryption 
Code field. 
 
Make sure the Encryption Code is the same with the access point’s encryption 
code that DCS-1000W is to be connected under Infrastructure mode. Your 
PC/Notebook’s encryption code also needs to be setup the same with the 
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DCS-1000W's encryption code under either Infrastructure mode or Ad-hoc 
mode. 
 
The default setting for the Encryption Key is “Disable”. Therefore, to secure 
the wireless transmission be sure to Enable the Encryption Key by entering the 
relevant data. 
 
Note: 
Carefully input the Encryption Code, any error setting the code will cause the 
communication link to fail. 

 
LED Control: 
The LED control allows you to setup the LED illumination as desired. This 
feature provides the flexibility when surveillance activity is ON. 

There are three options as follows: 
§ Normal 

Power - Steady On of the LED indicator.  
LAN/WLAN - Steady On of the LED indicator. When 
LAN/WLAN activity is present the LED indicator will flash 
steadily. 

§ OFF  
Power - LED indicator is off 
LAN/WLAN – LED indicator is off 

§ Dummy 
Power - Steady On of the LED indicator. 
LAN/WLAN - Steady On of the LED indicator with random 
flashing. 
 

The default setting for the LED control is “Normal”. When you have 
configured the LED control the correct illumination will set in after 1 minute. 
 
Note: 
This function is built-in to the LED indicators to add extra capabilities. The 
three options allow the Administrator to configure and camouflage the 
illumination for the LED indicator to falsify the monitoring status. In Normal 
Mode the LED indicator functions normally. Under Off Mode the LED 
indicators are both off, however, it is still monitoring the activity. In Dummy 
Mode the LED indicators operate in monitoring condition but monitoring 
activity is off or on. 
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Loading ActiveX From: 
This field is used to specify the location of Xplug Control (ActiveX) plug-in 
program. Enter the information as required in .ocx format, for example: 
http://www.<your company>.com/xplug.ocx where <your company> must be 
replaced with your company’s DNS server. 
 
Instructions for installing ActiveX from the driver CD is included in this 
manual. Refer to the section labeled "Software Installation”. 
 
Open Second Port: 
The Web Server field allows settings to open a second port for the DCS-
1000W. This will permit users of IP Sharing Gateways to support multiple 
DCS-1000Ws. By default Port 80 is always opened for DCS-1000W Web 
Server access. Select “Yes” and input the second port value.  
 
For example: If you have 5 Internet Cameras to be installed, each with an IP 
address from  
 
192.168.0.101 
192.168.0.102 
192.168.0.103 
192.168.0.104 
192.168.0.105 
 
You can open the second port for each Internet Camera from port 81 to Port 
85 as illustrated below: 
 
DCS-1000W 1 – IP 192.168.0.101, second web port 81 
DCS-1000W 2 – IP 192.168.0.102, second web port 82 
DCS-1000W 3 – IP 192.168.0.103, second web port 83 
DCS-1000W 4 – IP 192.168.0.104, second web port 84 
DCS-1000W 5 – IP 192.168.0.105, second web port 85 
 
You also need to setup your DSL gateway for Port Mapping. 
 
Port 81 map to 192.168.0.101 
Port 82 map to 192.168.0.102 
Port 83 map to 192.168.0.103 
Port 84 map to 192.168.0.104 
Port 85 map to 192.168.0.105 
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The Transfer Image field allows settings to open a second port for the DCS-
1000W to transfer images. The default Port “8481” is open image transfer and 
you can define a second port similar to above. 
 
Save/Cancel: 
After making sure all settings in the System are correct, click on the “Save” 
icon to store the settings in the DCS-1000W. You can alternatively click on 
the “Cancel” icon to restore all settings to the values last saved to or retrieved 
from the DCS-1000W. 
 
System Administration - Image 
Image menu in the system administration contains commands to provide the 
settings for the images captured by DCS-1000W. 
 
Click on “Image” in the system administration menu bar and the Image 
screen will appear as illustrated below:  
 

 
 
Video Resolution: 
Select the desired video resolution format ranging from 160x112, 320x240 
(default) or 640x480 
 
Compression Rate: 
Select the desired compression rate with five levels from very low to very high. 
Higher video compression rate will generate more compact file size with less 
video quality and vise-versa. The default setting is “Medium”. 
 

Click on “Home” to 
return to Home Screen 
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Frame Rate: 
Select the frame rate  desired with default setting at Auto for optimal frame 
rate. A setting of “Auto” will get best results. 
 
Brightness Control: 
Adjust the brightness level with default setting of 64. 
 
Contrast Control: 
Adjust the contrast level with default setting of 64. 
 
Hue Control: 
Adjust the hue level with default setting of 64. 
 
Light Frequency: 
Adjust the light frequency to suit your area of operation from the options 
either 50 Hz or 60 Hz (default). 
 
50 Hz and 60 Hz variants are available to accommodate the different light 
frequency found in USA (60 Hz) and Europe (50 Hz) for the DCS-1000W to 
ensure better image quality. 
 
Save/Cancel: 
After making sure all settings in the System are correct, click on the “Save” 
icon to store the settings in the DCS-1000W. You can alternatively click on 
the “Cancel” icon to restore all settings to the values last saved to or retrieved 
from the DCS-1000W. 
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System Administration - Users 

The User options menu contains commands to allow system administrator to 
assign legal users who are permitted to monitor the DCS-1000W from a 
remote site. 
 
Click on “Users” in the system administration menu bar and the Users screen 
will appear as illustrated below: 

 

 
 
 
Add User: 
User Name: 
Enter the user name in this field. 
 
A maximum of 64 users names are allowed, however each users name must be 
different. Each user name can be used as a group given the password for 
example, if the User Name is “Guest” and the User Password is “Guest” 
anyone can access the DCS-1000W with these details used as a group of users 
under the User Name “Guest”. The maximum length for the User Name is 12 
characters (Printable ASCII). 
 
User Password: 
Enter the user’s password you want to assign to the specific user-name. The 
maximum password length is 8 characters (Printable ASCII). 
 
I/O Output Control: 
The Administrator has the authority to give permission to control the I/O 
Output Control to users by selecting “Yes” or “No” to activate the I/O Output 
control.  
 
To add a new user name input the necessary information first and click on the 
“Add” icon. 

Click on “Home” to 
return to Home Screen 
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Delete User: 
Select the user you wish to delete from the pull down menu and click on the 
“delete” icon. 

Important Information 
 

Once administrator has configured DCS-1000W Users, any user will be required to 
enter a login password to access the video image from DCS-1000W. The password 
dialog box is illustrated below. 
 

 
 
System Administration – DateTime 
The DateTime menu contains commands for setting the DCS-1000W's time 
and date requirements to provide correct information to users who might be 
thousands of miles away in the remote site. There are two options to select 
from the DateTime menu bar, either Synchronized with Time Server or Set 
Manually. 
 
Click on “DateTime” in the system administration menu bar and the 
DateTime screen will appear as illustrated below: 

 
Click on “Home” to return 

to Home Screen 
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DateTime: 
Select “Synchronized with Time Server”  and the time will be based on 
GMT setting. The time will be synchronized every 10 minutes. This is also the 
default setting for DCS-1000W. 
 
IP Address: 
Enter the IP Address of the Time Server in this field. 
 
Protocol: 
Two options of NTP or Time are available for your selection to link with the 
Time Server. The default setting is NTP. 
 
TimeZone: 
System administrator must select the time zone for the region. Please refer to 
the appendix for the time zone selection table. 
 
To set the Date Time manually select “Set Manually”. The system 
administrator must then enter the Date and Time in the respective field 
manually. 
 
When you select “Set Manually”, each time the DCS-1000W is powered off 
and on you must re-enter the details once again due to time lost. 
 
Note: 
Please find below NTP server web address for your reference to set the time 
server. 

http://www.eecis.udel.edu/~mills/ntp/clock1.htm 
http://www.eecis.udel.edu/~mills/ntp/clock2.htm 

 
Save/Cancel: 
After making sure all settings in the System are correct, click on the “Save” 
icon to store the settings in the DCS-1000W. You can alternatively click on 
the “Cancel” icon to restore all settings to the values last saved to or retrieved 
from the DCS-1000W. 
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System Administration – Trigger  

The Trigger menu contains commands for the I/O Trigger connectors 
providing the physical interface for 2 digital outputs and 2 digital inputs that 
are used for connecting a diversity of external alarm devices to the DCS-
1000W such as IR-Sensor and alarm relay devices. 
 
Click on “Trigger” in the system administration menu bar and the Trigger 
screen will appear as illustrated below: 

 
 
The default setting for the I/O Trigger functions is “disabled” You must 
enable the I/O Trigger first before the Triggers will perform. 

 
There are two options to select from the Trigger screen I/O Input 1 Trigger 
and I/O Input 2 Trigger.  
 
I/O Input 1 Trigger: 
Select “Send e-mail attached with image” and enter the relevant information 
such as the SMTP Server Address, Sender e-mail Address, Receiver e-mail 
Address, Sending Interval and Sending Times. 
 

• SMTP (Simple Mail Transfer Protocol) is a protocol for sending e-
mail messages between servers you need to input the mail server 

Click on “Home” to 
return to Home Screen 
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address in this field. 
• Sender e-mail is the person’s e-mail address that will be sending the 

e-mail. 
• Receiver e-mail is the e-mail address of the person that will receive 

the e-mail. 
• Sending Interval is the period of time between each e-mail being sent 

to the receiver. If the setting is at 10 seconds, a new e-mail will be 
sent in 10 seconds interval to the receiver. 

• Sending Time  is the number of times the e-mail will be sent to the 
receiver before it terminates. 

 
Select “Trigger I/O Output” and enter the setting for the duration of the 
output device for Output 1 time and Output 2 time in seconds. 
 
I/O Input 2 Trigger: 
Refer to “I/O Input 1 Trigger” information above.  
 
Save/Cancel: 
After making sure all settings in the System are correct, click on the “Save” 
icon to store the settings for the DCS-1000W. You can alternatively click on 
the “Cancel” icon to restore all settings to the values last saved to or retrieved 
from DCS-1000W. 
 

Warning 
 

When connecting other devices through the I/O connectors, please make sure the 
maximum current of 100mA is strictly observed. Any failure to do so might cause a 
loss of power to DCS-1000W and possibly cause serious damage to the Internet 
Camera. 

 
Please refer to the appendix for detailed information regarding the I/O 
Connector. 
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System Administration - Information 

The Information menu contains commands for displaying information about 
the DCS-1000W. 
 
Click on “Information” in the system administration menu bar and the 
Information screen will appear as illustrated below: 
 

 
 
The Information table provides detailed information about the DCS-1000W 
such as the Model Name, Firmware Version, Mac Address, and IP Address. 
 
System Administration - Tools 
The Tools menu contains commands for restarting DCS-1000W. 
 
Click on “Tools” in the system administration menu bar and the Tools screen 
will appear as illustrated below: 
 

 
 
 
 
Reset: 
The Reset command restarts the DCS-1000W is you were to turn it off and 
then on again, with settings being retained The Reset panel contains the 
message “Do you really want to reset this device?” and a YES button. If you 
do not want to reset DCS-1000W, exit the panel without clicking YES, 
otherwise, click on the “YES” icon and the reset process will initiate. 

Click on “Home” to 
return to Home Screen 

Click on “Home” to 
return to Home Screen 
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Factory Reset: 
A factory reset restarts the DCS-1000W and returns all of its settings to their 
default values. The Factory Reset panel contains the message “Do you really 
want to factory reset this device?” and a YES button. If you do not want to 
carry out a factory reset command, exit the panel without clicking YES, 
otherwise click on the “YES” icon and factory reset will be initiated. 
 
Note: 
The Network setting must be reconfigured after a Factory Reset. 
 
Once the configuration is completed click on “Home” to return to the Home 
screen and select the desired Viewing Image either through ActiveX Mode or 
Java Mode as described in the next section. 
 
The last step is to position the DCS-1000W to the desired location appropriate 
for your purpose, followed by adjustment of the DCS-1000W focus, by 
manually turning the lens clockwise or anti-clockwise to the desire image 
quality. Please refer to the appendix for detailed information regarding 
Adjusting DCS-1000W Focus and Replacing the Lens. 
 

View Image – ActiveX Mode 
To view video images from the browser, click on “View Image – ActiveX 
Mode” from the Home screen to access the video images from Internet 
Explorer as illustrated below: 
 

 
 
Camera Name * - The Camera name will be display when the Camera Name 
field is entered in the Web Configuration setting under “System”. 

Location** 
Camera Name* 

Click on “Home” to 
return to Home Screen 
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Location**- The location of DCS-1000W will be displayed when the 
Location field is entered in the Web Configuration settings under “System”. 
 
Note: 
Please refer to the appendix on how to install ActiveX. 

1. Install to the Web Server 
2. Install to your Local PC 

 
In the View Image – ActiveX Mode you are allowed two output trigger 
options. Just click on the desired selection “ON” or “OFF” to utilize the 
options for each of the output triggers (Output 1 trigger or Output 2 trigger). 
 
Note 1:  
Output trigger will send a 5V signal to the device connected to the DCS-
1000W. A maximum of two devices is permitted to connect to DCS-1000W to 
utilize the output trigger function. Please refer to appendix for detailed 
information. 

 
Note 2:  
The Administrator has the authority to allow user’s to set the output trigger 
functions through the setting in the “Users” of System Administration menu 
bar. 
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View Image – Java Mode 
Click on “View Image – Java Mode” from the Home screen to access the 
video images from the Internet Explorer or Netscape browser as illustrated 
below: 
 

 
 
Camera Name* - The Camera name will be display when the Camera Name 
field is entered in the Web Configuration setting under “System”  
 
Location** - The location of DCS-1000W will be displayed when the 
Location field is entered in the Web Configuration settings under “System”. 
 
In the View Image – Java Mode you are allowed two output triggers. Just click 
on the desired selection “ON” or “OFF” to utilize the options for each of the 
output triggers (Output 1 trigger or Output 2 trigger). 

 
Note 1:  
Output trigger will send a 5V signal to the device connected to DCS-1000W. 
A maximum of two devices is permitted to connect to DCS-1000W to utilize 
the output trigger function. Please refer to appendix for detailed information. 

 
Note 2:  
Administrator has the authority to allow user’s the permission to set the output 
trigger functions through the setting in the “Users” of System Administration 
menu bar. 
 

Location** 

Click on “Home” to 
return to Home Screen 

Camera Name* 
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IPView Application Installation 
 

Installation 
Insert the CD-ROM into the CD-ROM drive to initiated the auto-run program. 
Once completed a menu screen will appear as follows: 

 
 

To install the IPView application click on the "IPView" button to activate 
the installation procedure for the application program. 
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Once executed a prompt will appear requesting the input of the desired 
language selection. Make the desired selection and click on “OK” to continue. 
 

 
 
The Welcome screen will appear. Click on the “Next” button to proceed with 
the installation.  
 

 
 
 



 34 

The License Agreement prompt will appear as below. Read the details 
carefully and click on the “Yes” icon to continue with the installation 
procedure. 
 

 
 
 
A prompt will appear and in the Destination Location dialog box, you may 
click on “Next” to accept the recommended destination location or click on 
“Browse” to select another location. After specifying the desired destination 
location, click on “Next” to proceed further.  
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The Select Program Folder prompt will appear providing information of where 
the IPView application will be located, click on “Next” to continue. If you 
wish to modify your settings, click on “Back” to return to the previous 
screens. 
 

 
 
 
Please wait until one of the two dialog box to appear, select either “Yes, I want 
to restart my computer now” and click on the “Finish” icon to restart the 
computer to complete the installation procedure. 
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or click on the “Finish” icon to complete the installation procedure 
 

 
 

After successfully installing the IPView, the application program for DCS-
1000W is automatically installed to \Programs\Files Directory. 
 
To start running the IPView click on windows Start > Menu > Programs > 
IPView >IPView  
 
Once IPView is executed a Login prompt will appear, you must enter the 
default User Name: admin into the respective field and click on “OK” to log 
into the application. 
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Once logged in, the IPView application is executed and the IPView interface 
will appear as follows in the default List View format: 
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IPView – Getting Started 
 
This section describes the operation of the IPView application User Interface 
with detailed procedures for using the application. 
 

IPView 
IPView is responsible for the management of preview, configuration, and 
searching of each camera. 
 
It is designed with a user-friendly interface for ease of control and navigation 
requirements as illustrated below. 
 

 
 

 
 
 
 

List view format 
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How to Change Password 
Change Password 
When IPView is used for the first time it is highly recommended to change the 
User Name  and Password by the Administrator to constrain users access to 
the IPView application. Once the User Name  and Password are defined only 
the Administrator has access to the management of IPView applications. This 
procedure should be done as soon as possible to prevent unauthorized usage of 
IPView application.  
 
Once IPView is executed a Login prompt will appear, you must enter the 
default User Name : admin into the respective field and click on “OK” to log 
into the application. 
 

 
 
To change the User Name  and Password select “Tools” > “Options”. The 
Options  dialog box will appear as illustrated below. 
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The administrator needs to enter a User Name , Password and Confirm 
password into the respective fields. Once all the new details are entered click 
on the “OK” icon.  
 
Make sure to save any changes you have made to keep the information 
updated. 
 
Note: 

Alternatively you can click the Options  icon  as illustrated or use the hot 
key “F10”. 
 

How to Change IP Address 
Change IP Address 

To change an IP Address for a camera select “Camera” > “Add”. An Add 
Camera dialog box will appear as illustrated below. 
 

 
 
Click on the “Browse” icon, the Browse Camera dialog box will appear with 
a blank screen as illustrated below.  
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Click on the “Search” icon and IPView will detect and search all the available 
camera’s that are installed on the local area network as depicted below: 
 

 
 
You must highlight the camera you wish to change the IP Address and click 
on the “Change IP” icon and the Change IP Address dialog box will appear 
as depicted below: 
 

 
 
Enter the new IP Address along with the Subnet Mask and Default gateway 
into the respective fields and click on the “OK” icon and IPView will 
automatically change the IP Address. 
 
Make sure to save any changes you have made to keep the information 
updated. 
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How to Add a Camera 
Add Camera 

To add a new camera select “Camera” > “Add”. An Add Camera dialog 
box will appear as illustrated below. 
 

 
 
You can enter the IP Address of the camera in the specified field and click the 
“Add” icon to add a new camera. If the IP Address is entered incorrectly a 
dialog box will appear to notify the error.  
 

 
 
If you are unsure of the IP Address of the camera you can click on the 
“Browse” icon, the Browse Camera dialog box will appear with a blank 
screen as illustrated below.  
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Click on the “Search” icon and IPView will detect and search all the available 
camera’s that are installed on the local area network as depicted below: 
 

 
 
You must highlight the camera you wish to add and click on the “Add”  icon. 
The Add Camera dialog box will appear once again with the IP Address 
entered. Click on the “Add”  icon and the camera will be automatically added 
into IPView list view format. 
 
Alternatively you can double click on the camera you wish to add and the Add 
Camera dialog box will appear once again with the IP Address entered. Click 
on the “Add” icon and the camera will be automatically added into IPView 
list view format. 
 

 
 



 44 

If the Login Camera dialog box appears make sure to enter the correct User 
Name and Password and click on the “OK” icon and the camera will be 
added into IPView in list format. If the User Name  and Password is entered 
incorrectly the camera will not be added into IPView. 
 

 
 
The above dialog box will appear only if administrator has already set the 
User Name  and Password during the Web Configuration setting. 
 
If you forget to highlight the camera you wish to add a dialog box will appear 
to notify you of the error. 
 

 
 
Make sure to save any changes you have made to keep the information 
updated. 
 
Note 1: 
You are only able to add one camera at a time. 
 
Note 2: 

Alternatively you can click the Add icon  as illustrated or use the hot key 
“Shift+Ins”. 
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How to Delete a Camera 
Delete Camera 

To delete a camera you must highlight the camera you wish to delete from 
IPView list view format. From the menu bar select “Camera” > “Delete”. A 
Delete Camera dialog box will appear and click on the “Yes” icon to delete 
the camera or click on “No” if you do not wish to delete the camera as 
illustrated below. 

 

 
 
Make sure to save any changes you have made to keep the information 
updated. 
 
Note: 

Alternatively you can click the Delete icon  as illustrated or use the hot key 
“Del” . 
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How to View a Camera 
View Camera 
From the menu bar select “View” > “4 Cameras” (other choices are available 
in 1 Camera, 9 Cameras  and 16 Cameras viewing format) and the viewing 
screen will appear with the video image 
 
 

 
 
Note: 
The icon on the upper left corner of the screen will appear with the camera 
number that is being displayed 
 
To return to the IPView list view format, click on the icon located on the 
upper left corner of the screen and a case sensitive menu will appear. Select 
“List” and the viewing image will return to the list view format. 
 
Note 1: 
A maximum of 16 cameras are available for viewing with the IPView 
application.  
 
Note 2: 

Alternatively you can click the 1 Camera icon  as illustrated or use the hot 

key “Ctrl+F3”. For 4 Cameras  , 9 Cameras  and 16 Cameras   
click the respective icon or use the hot key as follows “Ctrl+F4”, “Ctrl+F5” 
and “Ctrl+F6”. To return to list view format use the hot key “Ctrl+F1”. 
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How to take a Snap-Shot of a Camera 
Snap shot Camera 
 
To snap shot a camera you must highlight the camera you wish to snap shot 
from the list view format. From the menu bar select “Camera” > “Snap 
shot”. A Save Image dialog box will appear for you to save the snap shot 
picture. 

 
A second alternative is from the viewing mode either 1, 4, 9, 16 cameras click 
on the icon located on the upper left corner of the screen and a case sensitive 
menu will appear and select the “Snap shot” icon. A Save Image dialog box 
will appear for you to save the snap shot picture. 
 
Note: 

Alternatively you can click the Snap shot icon  as illustrated or use the hot 
key “F5 ”. 

  

How to Adjust the Property Setting 
Property Setting 
 
“Property” is initiated by selecting “Camera” > “Property” and a dialog 
box will appear allowing settings of Web Configuration and upgrade firmware 
(Please refer to the appendix for detailed information). The Camera Property 
dialog box will appear for you to select the desired options from the tab 
selections to Configure the camera as shown below. 
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General 
Allows settings for the camera name, location and administrator information 
such as administrator ID and password. Please refer to the Web Configuration 
section under “System Administration – System”  for further details. 
 

 
 

IP Assignment 
There are two options to select from the IP Assignment either Manually 
Assign or Assign Automatically Using. Please refer to the Web 
Configuration section under “System Administration – System” for further 
details. 
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DNS 
DNS (Domain Name System) server is an Internet service that translates 
domain names into IP addresses. Enter at least one DNS IP Address. Please 
refer to the Web Configuration section under “System Administration – 
System”  for further details. 
 

  
 
Wireless (Please skip this section if your camera is not wireless) 
 
Allows setting for connection mode, network name, wireless channel, and 
WEP key. Please refer to the Web Configuration section under “System 
Administration – System”  for further details. 
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Misc 
Allows setting for LED Control, ActiveX control location, and second port. 
Please refer to the Web Configuration section under “System 
Administration – System”  for further details. 
 

 
 
Image 
Image provides the settings for the video image of the camera such as 
brightness, contrast, hue, resolution, compression, frame rate, and light freq. 
Please refer to the Web Configuration section under “System 
Administration – Image” for further details. 
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Users  
Contain commands to allow system administrator to assign legal users who are 
permitted to monitor the camera from the remote site by Add or Delete  user.  
 

 
 

To add a user click on the “Add” icon and the Add User dialog box will 
appear. Enter the User Name and Password into the specific field. Select the 
I/O Output Control to give users the privilege of accessing the I/O Output 
Control. 

 
 
To delete a user, select the user and click on the “Delete” icon. 
 
Please refer to the Web Configuration section under “System 
Administration – Users” for further details. 
 
Date/Time  
Contain commands for setting the camera’s time and date to provide correct 
time information to users who might be thousands of miles away in the remote 
site by selecting Synchronized with Time Server or Set Manually. Please 
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refer to the Web Configuration section under “System Administration – 
TimeDate” for further details. 
 

 
 
Trigger 1 
Contains commands for setting the I/O Trigger connectors providing the 
physical interface for 1 digital output and 1 digital input that is used for 
connecting a diversity of external alarm devices to the camera such as IR-
Sensor and alarm relay. Please refer to the Web Configuration section under 
“System Administration – Trigger”  for further details. 
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Trigger 2 
Contains commands for setting the I/O Trigger connectors providing the 
physical interface for 1 digital output and 1 digital input that is used for 
connecting a diversity of external alarm devices to the camera such as IR-
Sensor and alarm relay. Please refer to the Web Configuration section under 
“System Administration – Trigger”  for further details. 
 

 
 
Information 
Displays information about the camera such as the model, firmware version, 
MAC address, and IP address. Please refer to the Web Configuration section 
under “System Administration – Information” for further details. 
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Tools  
Contains commands to reset the camera and update firmware (please refer to 
the appendix for detailed information). Please refer to the Web Configuration 
section under “System Administration – Tools” for further details on reset. 
 

 
 
Make sure to save any changes you have made to keep the information 
updated. 
 
Note: 

Alternatively you can click the Property icon  as illustrated or use the hot 
key “F2”. 
 
Menu Bar 
The menu bar provides easier access for users to navigate the IPView with 
different selections along with hot key capabilities as follows: 
 
Menu Bar - File   
“File” on the menu bar provides “New” , “Open”, “Save”, “Save As” and 
“Exit” for users to create new files, open existing files, save files, and exit the 
IPView as depicted below.   
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Menu Bar – View 
“View”  on the menu bar provide users with management capabilities for 
“Columns”, “List”, “Camera” and “Refresh”. You can view Camera in “1 
Camera”, “4 Cameras”, “9 Cameras”, “16 Cameras”. The “View” menu 
bar is pictured below. 
 

 
 
Columns 
When “Columns” is launched a dialog box will appear allowing the option to 
choose the columns one would like to display in List View as illustrated below. 

 
Viewing Format 
You can view the format in “List” view. The “List” viewing format allows 
easy management and control of each camera.  
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List View 

“List” view is illustrated below for your reference. You are able to list all the 
cameras and their properties such as the camera name, IP address, user name, 
and location will be displayed for ease of control and management. 
 

 
 
Note: 
Right click the mouse pad on any kind of the camera will bring up a context 
sensitive menu which shows the actions you can apply to the selected camera. 
 
Double click on the desired camera will bring up the Property dialog box.  
 
To update camera list view just click on the “Refresh”  icon for Real Time 
Data and the latest information. 
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Menu Bar - Camera 

“Camera” on the menu bar provides options to manage the camera. One can 
“Add” additional Camera with a maximum of 16 Camera allowed for viewing. 
Through the management function one can “Delete” a camera, manage the 
“Property”, “Enable” for real time and take a “Snap shot” image. The menu 
bar is illustrated below: 
 

 
 

Enable Function 

By default the video image is enabled. There will be a “check” next to the 
Enable command to show that the Enable function is working. To disable 
real-time image select “Camera” > “Enable” and real-time video image will 
stop and shutdown. 
 
Menu Bar - Tools 
"Tools" on the menu bar allows administrator management of the security 
settings such as User Name and Password to gain access into the IPView 
application. From the menu bar select "Tools” > "Options" and a dialog box 
will appear. Administrator can change the User Name and Password for 
security settings to access the application.  

 

 
 

Menu Bar - Help 

“Help” on the menu bar provides “Contents” and “About” to instruct users 
how to operate the camera in HTLM format. From the menu bar select “Help” 
and can choose either “Contents” or “About” as depicted below: 
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IPView Icon Description 
 

 Open a new file. Alternatively the hot key is Ctrl+N. 
 

 Open an existing file. Alternatively the hot key is Ctrl+O. 
 

 Save a file. Alternatively the hot key is Ctrl+S. 
 

 List view format. Alternatively the hot key is Ctrl+F1. 
 

 1 Camera view format. Alternatively the hot key is Ctrl+F3. 
 

 4 Camera view format. Alternatively the hot key is Ctrl+F4. 
 

 9 Camera view format. Alternatively the hot key is Ctrl+F5. 
 

 16 Camera view format. Alternatively the hot key is Ctrl+F6. 
 

 Refresh IPView application. Alternatively the hot key is F12. 
 

 Add a camera. Alternatively the hot key is Shift+Ins . 
 

 Delete a camera. Alternatively the hot key is Del. 
 

 Property setting to configure the camera. Alternatively the hot key is F2. 
 

 Snap shot to capture a single still image. Alternatively the hot key is F5. 
 

 Options to modify the User Name and Password for IPView. Alternatively 
the hot key is F10. 
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Context Sensitive Menu 
In list view format by highlighting a camera and right clicking the mouse pad 
will bring up a context sensitive menu for features such as “Add”, “Delete”, 
“Property”, “Enable”, and “Snap shot”. 
 

 
 
In view mode format click on the icon located on the upper left corner of the 
screen and a case sensitive menu will appear as illustrated below.  
 

 
 
Features such as “Enable”, “Snap shot”, “List”, “1 Camera”, “4 Cameras”, 
“9 Cameras”, “16 Cameras”, “Previous Page” and “Next Page” will be 
available.  
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Uninstall IPView Application  
Click on windows Start Menu / Settings / Control Pane l. A prompt screen 
will be displayed like the one below and double click on the Add/Remove 
Programs  icon. 

 
 
From the Add/Remove Programs Properties Menu, select “IPView” as 
illustrated below. 
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Then click on the “Add/Remove” button. A new prompt screen will be 
displayed like the one below confirming the removal.  
 
Click on the “OK” icon to continue the process or click on the 
“Cancel” icon to reject the uninstall process. 
 

 
 
The InstallShield Wizard prompt will appear and click on “Finish”  to 
complete the uninstallation procedure. 
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Appendix 
 
Frequently Asked Questions 

Internet Camera Features 

Q: What is an Internet Camera? 
A: DCS-1000W is a standalone system connecting directly to an Ethernet or 
Fast Ethernet network and supported by the wireless transmission based on the 
IEEE 802.11b standard. It is different from the conventional PC Camera, the 
DCS-1000W is an all-in-one system with built-in CPU and web-based 
solutions providing a low cost solution that can transmit high quality video 
images for monitoring. The DCS-1000W can be managed remotely, accessed 
and controlled from any PC/Notebook over the Intranet or Internet via a web 
browser.  
 
Q: What is the maximum number of users that can be allowed to access 
DCS-1000W simultaneously? 
A: Maximum number of users that can log onto the DCS-1000W at the same 
time is 64. Please keep in mind the overall performance of the transmission 
speed will slow down when many users are logged on.  
 
Q: What algorithm is used to compress the digital image? 
A: The DCS-1000W utilizes JPEG image compression technology providing 
high quality images. JPEG is a standard for image compression and can be 
applied to various web browser and application software without the need to 
install extra software. 
 
Q: Can I change the wireless antenna attached to DCS-1000W? 
A: The wireless antenna can be changed for a variety of reasons such as 
extending the wireless transmission range, however, please consult authorized 
distributors before attempting as the connectors must be SMA connector type. 
 
Q: Can I capture still images from the DCS-1000W? 
A: Yes you are able to capture still images with the snapshot function from the 
IPView application supplied with the DCS-1000W CD-ROM. You may also 
use the first page that shows up with you type in the IP address of the camera. 
When viewing this page, press the “refresh” button on your web browser to 
update the image. Please refer to the User’s Guide for detailed information. 
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Q: What is the wireless transmission range for the DCS-1000W? 
A: Generally the wireless distance can go up to 100 meters indoors and 
up to 300 meters outdoors. The range is limited by the number of walls, 
ceilings, or other objects that the wireless signals must pass through. 
Typical ranges vary depends on the types of materials and background 
Radio Frequency (RF) noise in your home or business and the 
configuration setting of your network environment.  
 
Internet Camera Installation  

Q: Can the Internet Camera be used outdoors? 
A: The DCS-1000W is not weatherproof. It needs to be equipped with a 
weatherproof case to be used outdoors and it is not recommended. 
 
Q: What network cabling is required for the DCS-1000W? 
A: DCS-1000W uses Category 5 UTP cable allowing 10 Base-T and 100 
Base-T networking. 
 
Q: Can the DCS-1000W be setup as a PC-cam on the computer? 
A: No, the DCS-1000W is an Internet Camera used only on Ethernet and Fast 
Ethernet network and supported by wireless transmission. The D-Link DSB-
C100, DSB-C300, DSC-350 or DSC-350F can be used as a PC Camera 
(Webcam). 
 
Q: Can the DCS-1000W be connected on the network if it consists of only 
private IP addresses? 
A: DCS-1000W can be connected to a LAN with private IP addresses. 
 
Q: Can the DCS-1000W be installed and work if a firewall exists on the 
network? 
A: If a firewall exists on the network, port 80 is open for ordinary data 
communication. However, since DCS-1000W transmits image data, the 
default port 8481 is also required. Therefore, it is necessary to open port 8481 
of the network for remote users to access DCS-1000W. 
 

Trouble Shooting 

 
Q: I cannot access the DCS-1000W from a web browser? 
A1: The possible cause might be the IP Address for the DCS-1000W is 
already being used by another device. To correct the possible problem, you 
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need to first disconnect the DCS-1000W from the network. Then run the 
PING utility (follow the instructions in Appendix B - PING Your IP Address). 
 
A2: Another possible reason is the IP Address is located on a different subnet. 
To fix the problem, run the PING utility (follow the instructions in Appendix 
B - PING Your IP Address). If the utility returns “no response” or similar, the 
finding is probably correct, then you should proceed as follows:- 
 
In Windows 95/98/2000 and Windows NT, check that the IP Address of the 
DCS-1000W is within the same subnet as your workstation.  
§ Click “Start”, “Setting”, “Control Panel”, and the “Network” icon. 
§ Select TCP/IP from the “Network” dialog box and from the “TCP/IP 

Properties” dialog box click on “Specify an IP address”. 
§ If the DCS-1000W is situated on a different subnet than your workstation, 

you will not be able to set the IP address from this workstation. To verify 
make sure the first 3 sections of the IP address of the DCS-1000W 
corresponds to the first 3 sections of the workstation. Therefore the IP 
address of the DCS-1000W must be set from a workstation on the same 
subnet. 

 
A3: Other possible problems might be due to the network cable. Try replacing 
your network cable. Test the network interface of the product by connecting a 
local computer to the unit, utilizing a standard Crossover (hub to hub) Cable. 
If the problem is not solved the DCS-1000W might be faulty.  
 
Q: Why does the Power LED not light up constantly? 
A: The power supply used might be at fault. Confirm that you are using the 
provided power supply, which is DC 5V, for the DCS-1000W and verify that 
the power supply is well connected. 
 
Q: Why does the LAN/WLAN LED not light up properly? 
A1: There might be a problem with the network cable. To confirm that the 
cables are working, PING the address of a know device on the network. If the 
cabling is OK and your network is reachable, you should receive a reply 
similar to the following (…bytes = 32 time = 2 ms). 
 
A2: The network device utilized by the DCS-1000W is not functioning 
properly, such as hubs or switches. Confirm the power for the devices are well 
connected and functioning properly. 
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A3: The wireless connection might be at fault. In ad-hoc mode make sure the 
DCS-1000W wireless channel and ESS-ID is set to match the PC/Notebook 
wireless channel and ESS-ID for direct communication. Since The DCS-
1000W ad-hoc mode supports two modes (802.11 ad-hoc mode and 
proprietary ad-hoc mode), make sure that you are using the same mode on 
each device. If they are not the same, the camera will not be accessible. 
 
Under infrastructure mode make sure the ESS-ID on the PC/Notebook and 
DCS-1000W must match with the Access Point’s ESS-ID. 
 
Q: Why does the DCS-1000W work locally but not externally? 
A1: Might be caused from the firewall protection. Check the Internet firewall 
with your system administrator. The firewall may need to have some settings 
changed in order for the DCS-1000W to be accessible outside your local LAN.  
 
A2: Make sure that the DCS-1000W isn’t conflicting with any web server you 
may have running on your network.  
 
A3: The default router setting might be a possible reason. Check that the 
configuration of the router settings allow the DCS-1000W to be accessed 
outside your local LAN. 
 
Q: Why does a series of broad vertical white line appear through out the 
image? 
A: It could be that the CMOS sensor has become overloaded when it has been 
exposed to bright lights such as direct exposure to sunlight or halogen lights. 
Reposition the DCS-1000W into a more shaded area immediately as 
prolonged exposure to bright lights will damage the CMOS sensor. 
 
Q: The focus on the DCS-1000W is bad, how can I correct it? 
A1: Adjust the DCS-1000W focus manually as described in “Adjusting the 
DCS-1000W Focus” in the Appendix section of this manual.  
 
A2: If you have previously changed the supplied CS-type lens, you may have 
unintentionally installed a C-type lens without fitting the adaptor first. 
 
Q: Noisy images occur. How can I solve  the problem? 
A1: The video images might be noisy if the DCS-1000W is used in a very low 
light environment. To solve this issue you need more lighting.  
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A2: There might be wireless transmission interference. Make sure there are no 
other wireless devices on the network that will affect the wireless transmission. 
 
Q: The images is of poor quality, how can I improve the image quality? 
A1: Make sure that your computers display properties are set to at least 15-bit 
color. Using 16 or 256 colors on your computer will produce dithering 
artifacts in the image, making the image look as if it has bad quality. 
 
A2: The configuration on the DCS-1000W image display is incorrect. 
Through the Web Configuration Image section of the web management you 
need to adjust the image related parameter for improve images such as 
brightness, contrast, hue and light frequency. Please refer to the Web 
Configuration section for detail information. 
 
Q: There are no images available through the web browser?  
A1: The ActiveX might be disabled. If you are viewing the images from 
Internet Explorer make sure ActiveX has been enabled in the Internet Options 
menu. Alternatively, you can use the Java Applet for viewing the required 
images. 
 
A2: If you are using Windows XP, please make sure that you have 
downloaded Java and installed it properly. 
 
A3: Make sure that your web browser supports Java. If you are using Internet 
Explorer or Netscape Navigator with a version number of lower than 4, then 
you will need to upgrade your web browser software in order to view the 
streaming video transmitted by the DCS-1000W. 
 
 
 

How to PING Your IP Address 
The PING (Packet Internet Groper) command can determine whether a 
specific IP address is accessible by sending a packet to the specific address 
and waiting for a reply. It can also provide a very useful tool to confirm if the 
IP address conflicts with DCS-1000W over the network. 
 
Follow the step-by-step procedure below to utilize the PING command but 
first you must disconnect DCS-1000W from the network. 
 
Start a DOS window. 
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Type ping x.x.x.x, where x.x.x.x is the IP address of the DCS-1000W. 
 
The succeeding replies as illustrated below will provide useful explanation to 
the cause of the problem with DCS-1000W IP address. 
 

I/O Connector 
 
I/O Connector Definition for DCS-1000W 

An 8-pole connector is provided for auxiliary IO connections to the DCS-
1000W. 
 
The IO connector provides the physical interface for 2 digital outputs and 2 
digital inputs that are used for connecting a diversity of external alarm devices 
to the DCS-1000W such as IR-Sensor and alarm relay. 
 
The digital input is used for connecting external alarm devices and once 
triggered images will be taken and e-mailed. 
 
The supported transistor output can give a maximum of DC 5V to the 
externally connected alarm devices and once triggered the current will activate 
the devices. 
 

In 11 
In 12 

In 11 & In 12 is a pair for digital input. It works at voltage 5V 

In 21 
In 22 

In 21 & In 22 is a pair for digital input. It works at voltage 5V 

Out 1 + 
Out 1 - 

Out 1 + & Out 1 - is a pair for digital out. The out put voltage is 5 
V and maximum current is 100 mA  

Out 2 + 
Out 2 - 

Out 2 + & Out 2 - is a pair for digital out. The out put voltage is 5 
V and maximum current is 100 mA  
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I/O Schematic Diagram 

 
 
 
 
 
 
 
 
 
 
 
Note: 
Through the Web Configuration in the Trigger section, you must first enable 
the trigger function. Please refer to the Web Configuration section for detailed 
information. 

Warning 
 

1. When connecting a device to the Input connector, the device must be a 
passive component without voltage and electrical current. 

2. When connecting other devices through the Output connector, please 
make sure the maximum current of DC 5V, 100mA is strictly observed. 

3. Any failure of the above two points might cause serious damage to the 
camera. 
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Upgrade Firmware 
You can update the firmware from the IPView application. With IPView 
running, select Camera > Properties and the Camera Property dialog box 
will appear. Select the Tools  tab and enter the full path of the firmware binary 
file name in the Update Firmware field or you can click on the “Browse” 
button to select the file. Once the firmware file is entered click on the 
“Update” button to proceed with the update process. Once completed click on 
the “OK” icon as illustrated below 
 

 
 

Warning 
The download firmware procedure cannot be interrupted. If the network connection is 
broken during the download procedure it might possibly cause serious damage to the 
Internet Camera. 
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Time Zone Table 

GMT stands for Greenwich Mean Time, which is the global time that 
all time zones are measured from. 
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Xplug Control Installation 

Installation to a Web Server 
 

Important Information 
It is highly recommended to install the Xplug Control application to the Web 
Server for IE 5.0. It must be installed to a Public Domain with Fixed IP 
address. 
 
1. Installation: 

Copy the “xplug.ocx” file to any Web Server table. Note the web 
address of the file location so that you can use it in the next step. 

 
2. Configuration: 

From the Web Configuration menu select “System” and under the 
“Loading ActiveX From” input web server location  
(http://www.web server location.com/). 

 
Once the settings are completed you should now be able to access the Internet 
Camera from the web browser by selecting ActiveX mode. 
 
Note: 
Set your browser security level to “Low” so that your browser will allow 
ActiveX control of the camera. 
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Installation to a Local PC 

Insert the CD-ROM into the CD-ROM drive to initiate the auto-run program. 
Once completed a menu screen will appear as follows: 

 

To install Xplug Control click on the "Xplug Control" button to activate the 
installation procedure for the plug-in program. 

 

 

Once executed a prompt will appear requesting the input of the desired 
language selection. Make the desired selection and click on “OK” to continue. 
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The Welcome screen will appear. Click on the “Next” button to proceed with 
the installation. 
 

 
 
 
The License Agreement prompt will appear as below. Read the details 
carefully and click on the “Yes” icon to continue with the installation 
procedure. 
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Click on the “Finish”  button to complete Setup of the Xplug Control Utility 
program for the DCS-1000W. 
 

 
 
 
 

Adjusting the Cameras Focus 
The DCS-1000W features an exchangeable C/CS-type lens that can be used 
for different applications as necessary. It supports rotational focus control so 
the lens can be adjusted to focus under normal and stable conditions to 
maximize the image quality of the DCS-1000W. 
 
To adjust the focus of the lens you will need to turn the lens slowly in either 
clockwise or anti-clockwise direction until the desired image appears. DO 
NOT over-turn the lens in either of the directions as it will be out of focus. 
Unless you want to substitute the lens DO NOT unscrew more than 1.0mm 
apart from the Fixed Lens Assembly. 
 
To help you get the best image quality, keep in mind that while adjusting the 
DCS-1000W's focus you can preview the image quality from your Web 
browser. 
 
Please refer to the diagram below when adjusting the camera lens.
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Note : 
You can further adjust the DCS-1000W's image quality through the Web 
Configuration under System Admin istration - Image. Please refer to Web 
Configuration section for further details. 

Warning 
Direct exposure to sunlight may cause permanent damage to the CMOS sensor. 
Therefore do not expose the Internet Camera’s lens directly to sunlight. When 
operation is required in glaring light environment, it is recommended to use an iris 
lens. 

The Internet Camera is designed for indoor usage and if your application requires 
prolong exposure to sunlight, a sun visor is recommended to protect the Internet 
Camera. 

 

 

Camera Lens  
Adjust by turning 

clockwise or anti-clockwise 

Fixed Lens Assembly 
DO NOT adjust 
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Replacing the Lens 
Since the DCS-1000W is designed with a CS- mount, the lens equipped with 
the DCS-1000W can be replaced with any standard C or CS lens commonly 
used within the surveillance industry. 
 
Follow the instructions below to replace the supplied lens with any C or CS 
type lens. 
 
1. Unscrew the DCS-1000W lens 
2. When using a C-lens, attach the new lens to a CS-C adapter 
3. Screw the new lens onto the DCS-1000W. If appropriate, adjust the iris 

according to the prevailing light conditions. 
4. Refer to Adjusting the DCS-1000W Focus on the previous page. 
5. Refresh the web browser and monitor the results from the DCS-1000W.  
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Specifications 
 
Video specification 
Resolution:    640 x 480 pixel  
Sensor:     1/3” color CMOS sensor 
Gain control:    Automatic  
Exposure:    Automatic  
White Balance:     Automatic  
Shutter:     Electronics 1/60 ~ 1/15000 sec 
Minimum Illumination:  2.5lux@F1.4, 3000K color  
Focal Length:     6.0 mm 
Aperture:    f=1.8 
Focus Extent:     20 cm - � 
Lens mounting:    Fixed board lens, CS-mount type 
 
Image (Video Setting) 
Image compression:   JPEG 
Frame rate : 30fps@QCIF, 20fps@CIF, 3fps@VGA 
Compression Rate selection: 5 level (Very Low, Low, Medium, High, 

Very High) 
Frame rate setting: 1, 5, 7, 15, 20, auto (depends on the video 

format) 
Video resolution:      160x120, 320x240, 640x480 
Brightness control:  Range 1- 128 
Contrast control :    Range 1- 128 
Hue control:     Range 1- 128 
 
System Hardware  
LAN Connector: One RJ-45 port to connect to 10/100Mbps Ethernet, 

auto-sensed 
Wireless LAN:  Built-in 802.11b wireless LAN module  
   (Wi-Fi compliant) 
Generic I/O Port: Four I/O ports, two for input and two for output 

Total 8-pin: 
Pin 1 Input Port (I+) Pin 5 Output Port (I+) 
Pin 2 Input Port (I-) Pin 6 Output Port (I-) 
Pin 3 Input Port (II+) Pin 7 Output Port (II+) 
Pin 4 Input Port (II-) Pin 8 Output Port (II-) 

Note: 
The output voltage is DC 5V and maximum current is 100mA. 
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LED Indicator:  Power LED (Blue)   

LAN/WLAN Activity LED (Orange)   
Note: 
LED three mode setting can be changed by software. (Normal / Off / Dummy) 
Power Supply:   DC 5V/2.4A, switching type 
Power Communication:  6.5 Watt (1300mA x 5V) 
Slide Switch:   LAN/LAN&WLAN/WLAN 
Antenna Connector:  2 connectors 
 
Communication Support 
Communication:  10/100Mbps Ethernet only 

10/100Mbps Ethernet and 802.11b wireless LAN. 
802.11b wireless LAN only 

Encryption:  64 bit, 128 bit or OFF 
Communication protocol:  HTTP, FTP, TCP/IP, UDP, ARP,  

  ICMP, BOOTP, RARP, DHCP, PPPoE 
 
Web Configuration Requirements: 

§ Internet Explorer 5.0 or above or Netscape 6.0 or above 
§ CPU: Pentium II, 266 MHz or above 
§ Memory Size: 32 MB (64 MB recommended) 
§ VGA card resolution: 800x600 or above 
§ ActiveX Control requires IE4.0 or above (windows) 
§ Java Applet requires IE4.0 or above (Windows/Mac) or 

Netscape 4.0 or above (Windows/Mac/Linux) 
 
PC Requirements for IPView: 

§ Windows XP, Windows 2000, Windows Me, Windows 98SE/98 
§ Pentium III, 450 MHz CPU or above 
§ Memory Size of 128 MB (256 MB recommended) 
§ VGA card resolution of 800x600 or above 

 
Operating environment 
Operating temperature:  5° ~ 50° 
Storage temperature:  -25° ~ 50° 
Humidity:   5% ~ 95% non-condensing 
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EMI & Safety 
FCC, CE, VCCI 
 

Technical Support 
 
D-Link provides free technical support for customers within the United States 
during the warranty period. U.S. customers can contact D-Link Technical 
Support through our web site, e-mail or by phone.  
 

D-Link Technical Support over Telephone : 

1-800-758-5489 
24 Hours a Day, 7 Days a Week 

D-Link Technical Support over the Internet: 

www.dlink.com 
support@dlink.com 

 
If you are a customer residing outside of the United States, please refer to the 
list of D-Link locations that is included in the User’s Manual. 
 

Registration 
 
Register your DCS-1000W at http://support.dlink.com/registration/ 
 
 
 
 
 
 
 




